
Úvod do předmětu Aplikovaná statistika I

• Základńı informace o předmětu

– Kód předmětu: MAS10c

– Název předmětu: Aplikovaná statistika I

– Vyučuj́ıćı předmětu: Mgr. Veronika Bendová

– Kontakt na vyučuj́ıćı: 375612@mail.muni.cz; bendova.veroonika@gmail.com

– Konzultačńı hodiny: Dohodou

• Podmı́nky k źıskáńı zápočtu

– Aktivńı účast na cvičeńı s maximálńım počtem tř́ı absenćı (omluvené i neomluvené)

– Vypracováńı krátkého domáćıho úkolu zadaného na prvńım cvičeńı

– Vypracováńı sady př́ıklad̊u zadaných za domáćı úkol

– Poznámka: Zápočtová ṕısemka se neṕıše.

• Domáćı úkol

– Obsah: Šest až osm př́ıklad̊u (podle náročnosti)

– Obdob́ı zadáńı úkolu: Druhá polovina semestru

– Doba na vypracováńı domáćıho úkolu: 14 dńı

– Forma řešeńı úkolu: RSkript obsahuj́ıćı kompletńı řešeńı př́ıklad̊u, komentáře popisuj́ıćı postupy řešeńı
a interpretace źıskaných výsledk̊u

– Hodnoceńı úkolu: U každého př́ıkladu se hodnot́ı správnost řešeńı, design graf̊u, interpretace výsledk̊u,
komentáře použitých postup̊u a přehlednost kódu.

– Kontrola úkolu: Vyučuj́ıćı má 14 dńı na zkontrolováńı a opraveńı domáćıho úkolu.

– Splněńı úkolu: Źıskáńı alespoň 75 % bod̊u z maximálńıho možného počtu bod̊u. V př́ıpadě, že student
potřebný počet bod̊u neźıská, bude mu úkol jedenkrát navrácen k přepracováńı.

– Zvláštńı pravidlo: Student může domáćı úkol vypracovávat společně se svými spolužáky a konzultovat
s nimi řešeńı úkolu.

– Zvláštńı omezeńı: Student nesmı́ od spolužák̊u koṕırovat řešeńı, koṕırovat interpretace výsledk̊u
a koṕırovat kód. V př́ıpadě porušeńı docháźı k penalizaci domáćıho úkolu, jej́ıž mı́ra je stanovena
podle závažnosti porušeńı: od stržeńı extra bod̊u z celkového hodnoceńı úkolu až po neuznáńı řešeńı
úkolu a neuděleńı zápočtu.

• Daľśı doporučeńı pro studenty:

– Účast na přednáškách

– Domáćı př́ıprava na cvičeńı z hodiny na hodinu - pr̊uběžně si opakujte; principy se budou stále opakovat,
pr̊uběžné chápáńı látky usnadńı př́ıpravu na zkoušku

– Interagujte s vyučuj́ıćı, ptejte se, e-mailujte, konzultujte, pomáhejte si a hlavně tomu rozumějte :).
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• Doporučená a zaj́ımavá literatura:

– Aplikovaná statistika I: Sb́ırka řešených př́ıklad̊u

Soubor řešených př́ıklad̊u pokrývaj́ıćı svým obsahem látku prob́ıranou v kursu Apliko-
vaná statistika I. Sb́ırka slouž́ı k samostatnému domáćımu procvičováńı prob́ırané látky.
Obsahuje zadáńı př́ıklad̊u, výpočetńı řešeńı, řešeńı pomoćı softwaru a interpretace
výsledk̊u.
Citace: Bendová, V.: Aplikovaná statistika I: Sb́ırka řešených př́ıklad̊u; studijńı materiál

– Pr̊uvodce základńımi statistickými metodami

Doporučený text doplňuj́ıćı výklad z přednášek. Svým obsahem pokrývá látku prob́ıranou
v kursu AS I. Text je sepsán čtivou formou vhodnou pro studenty, kteř́ı se se statistickými
pojmy a metodami teprve seznamuj́ı. Obsahuje ilustračńı př́ıklady vhodné k procvičováńı
výpočt̊u prob́ıraných metod. Př́ıklady jsou řešeny pomoćı softwaru STATISTICA.
Citace: Bud́ıková M., Králová M., Maroš B.: Pr̊uvodce základńımi statistickými metodami,
Praha, Grada, 2010, ISBN 978-80-210-7752-2, 272 s.

– Základńı statistické metody

Doporučený text doplňuj́ıćı výklad z přednášek. Obsahově je kniha velmi podobná
Pr̊uvodci základńımi statistickými metodami, pokrývá tedy taktéž látku prob́ıranou v
kursu Aplikovaná statistika I. Je přehledněǰśı, ale stručněǰśı a neobsahuje tolik ilustračńıch
př́ıklad̊u. Př́ıklady nav́ıc obsahuj́ı pouze výpočetńı řešeńı bez využit́ı jakéhokoli softwaru.
Citace: Bud́ıková M., Lerch T., Mikoláš Š.: Základńı statistické metody, Brno, Masarykova
Univerzita, 2009, ISBN 978-80-210-3886-8, 170 s.

– Aplikovaná štatistická inferencia I

Pokročilá literatura doporučená pro studenty, kteř́ı již absolvovali kurs Aplikovaná statis-
tika I a chtěj́ı si prohloubit znalosti nabyté v kursu. Kniha obsahuje mnoho ilustračńıch
př́ıklad̊u zaměřených na analýzu antropologických dat s řešeńım pomoćı softwaru . Text
je však v́ıce odborný a vyžaduje jistou orientaci ve statistických pojmech.
Citace: Katina S., Kráĺık M., Hupková A.: Aplikovaná štatistická inferencia I., Brno:
MUNI Press, 2015, ISBN 978-80-210-7752-2, 306 s.

– Moderńı analýza biologických dat I

Literatura doporučená pro studenty, kteř́ı absolvovali kurs AS I a chtěj́ı si prohloubit
znalosti nabyté v kursu. Zaměřuje se na oblast regresńı analýzy, která je v kursu prob́ırána
pouze okrajově, ovšem má rozsáhlé využit́ı v praxi. Metody jsou ilustrovány na př́ıkladech
analýzy biologických dat. Kniha je psána vstř́ıcnou formou a obsahuje řešeńı pomoćı .
Citace: Pekár S., Brabec M.: Moderńı analýza biologických dat 1, Praha: Scientia, 2009,
ISBN 978-80-86960-44-9, 225 s.

– Moderńı analýza biologických dat II

Druhý d́ıl výše uvedené publikace zaměřuj́ıćı se na téma smı́̌sených regresńıch model̊u,
které nejsou v kursu prob́ırány, ale maj́ı rozsáhlé využit́ı v praxi. Vhodná jako základńı
literatura k analýze dat s opakovanými měřeńımi. Obsahuje opět př́ıklady z oblasti bio-
logie řešeńı pomoćı softwaru .
Citace: Citace: Pekár S., Brabec M.: Moderńı analýza biologických dat 2, Brno: MUNI
Press, 2012, ISBN 978-80-210-5812-5, 256 s.
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1 Základy práce se statistickým softwarem R

• Úvod a motivace

– Kvalitńı analýza dat je v dnešńı době často ned́ılnou součást́ı kvalitńıho antropologického výzkumu.

– Antropolog my měl mı́t alespoň základńı povědomı́ o principech vybraných statistických metod.

• Náplň kursu Aplikovaná statistika I:

– Představeńı vybraných statistických metod

– Aplikace statistických metod na konkrétńı datové soubory z oboru antropologie

– Výuka použit́ı statistického softwaru při datové analýze

• Výstup kursu Aplikovaná statistika I:

– Orientace v základńı statistické terminologii

– Schopnost samostatně přemýšlet nad vlastńımi daty

– Schopnost zvolit vhodné metody k seznámeńı s daty

– Schopnost provést samostatně analýzu dat pomoćı softwaru

– Správná interpretace źıskaných výsledk̊u

• Software a proč právě on?

– Existuje mnoho nástroj̊u umožňuj́ıćıch provedeńı statistické analýzy dat

∗ Tabulkový software MS Excel, statistický software STATISTICA

∗ Skriptovaćı programovaćı jazyky: Matlab,

– Výhody softwaru

∗ Živý programovaćı jazyk, který se neustále vyv́ıj́ı.

∗ Rozsáhlé množstv́ı funkćı a př́ıkaz̊u umožňuj́ıćı provedeńı libovolné datové analýzy.

∗ Volně stažitelná plnohodnotná licence softwaru

∗ Volně stažitelná př́ıslušenstv́ı k softwaru: baĺıčky funkćı, nápovědy, RStudio

∗ Krásná grafika umožňuj́ıćı vlastńı nastaveńı vzhledu graf̊u a animaćı

∗ Výborná nápověda + r̊uzná diskusńı fóra, která pomáhaj́ı naj́ıt řešeńı problémů

∗ Možnost vytvářet tzv. živé dokumenty: HTML stránky (R HTML), pdf dokumenty (R Sweave),
Word dokumenty (R Markdown) a interaktivńı aplikace (R Shiny)

– Nevýhody softwaru

∗ Programovaćı jazyk → je potřebné naučit se jeho syntaxi

∗ Baĺıčky funkćı vytvář́ı uživatelé→ je potřebné studovat nápovědu k použ́ıvaným funkćım pro źıskáńı
jistoty, že funkce funguj́ı dle našich předpoklad̊u

∗ Nápověda dostupná pouze v angličtině, většina diskuśı též v angličtině

• Citace a odkazy

– Citace softwaru : R CORE TEAM. R: A Language and Environment for Statistical Computing.
The R Project for Statistical Computing, 2017 [cited 2018 Sep 21]. URL: https://www.R-project.org/

– Html stránka pro software : https://www.r-project.org/

– Html stránka pro RStudio: https://www.rstudio.com/
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• RStudio: Uživatelsky př́ıstupné prostřed́ı pro práci se softwarem

– Po otevřeńı RStudia

∗ Zaháj́ıme nový projekt: File → New file → R Skript

∗ Ulož́ıme projekt: File → Save → ’Nazev projektu’ → Save

∗ Nastav́ıme absolutńı cestu do složky s projektem: Session → Set Working Directory → To
Source File Location

– Nyńı máme RStudio rozdělené na čtyři okna

1. Pracovńı/programovaćı okno

∗ Prostor pro vytvářeńı našeho kódu

∗ Kód = posloupnost př́ıkaz̊u a funkćı → vlastnosti funkce specifikujeme volbou jejich argument̊u

∗ Provedeńı př́ıkazu nebo funkce: Ctrl + Enter

2. Workspace

∗ Environment - Seznam proměnných uložených v paměti

∗ History - Seznam naposledy provedených př́ıkaz̊u

∗ Vymazáńı uložených proměnných: Session → Clear Workspace → Yes

3. Konzole (výstupové okno)

∗ Zobrazuje provedené př́ıkazy a jejich výstupy

∗ Vyčǐstěńı konzole: Ctrl+L

4. Multifunkčńı okno (obsahuje v́ıce záložek)

∗ Plots - Grafické okno

· Prostor pro zobrazeńı vykreslených graf̊u

∗ Packages - Seznam nainstalovaných baĺıčk̊u + instalace nových baĺıčk̊u

· Instalace baĺıčku nortest: Packages → Install → nortest → Install

∗ Help - Nápověda

· Každá funkce má svou nápovědu obsahuj́ıćı:

i. Description- stručný popis funkce

ii. Usage - tvar př́ıkazu se všemi povinně volitelnými argumenty

iii. Arguments - Předhled všech argument̊u (povině volitelných i volitelných)

iv. Values - popis výstup̊u funkce

v. Details - Bližš́ı detaily, např́ıklad o vzorćıch a metodách, na nichž je funkce založena

vi. See Also - tipy na př́ıbuzné funkce, které by nás dále mohly zaj́ımat

vii. Examples - Ilustračńı př́ıklady správného použit́ı funkce

– Nastaveńı vzhledu RStudia: Tools → Options → Appearance
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• Přehled základńıch matematických objekt̊u

– Proměnná = označeńı objektu (č́ıslo, vektor, matice, tabulka, funkce)

∗ Č́ıslo: a ← 3

∗ Vektor: a ← (3, 6, 9)

∗ Matice: A←
(

2 3 7
8 4 5

)

∗ Tabulka: Tab ←
s1 s2 s3

r1 2 3 7
r2 8 4 5

∗ Funkce: funkce()

· Objekt, do kterého vlož́ıme vstup (IN) a źıskáme výstup (OUT)

· sum(vektor) → č́ıslo

· matrix(vektor, 2, 2) → matice

· mean(matice) → č́ıslo

• Úvod do syntaxe programovaćıho jazyka

– Jazyk je tzv. case sensitive → názvy sum, Sum, SUM, sUm, sUM, . . . značńı r̊uzné objekty

– Vytvořeńı proměnné

∗ Č́ıslo:

a <- 3

∗ Vektor:

aa <- c(1.2, 5.3, 6.4)

∗ Matice:

A <- matrix(c(1, 2, 3, 4, 5, 6), nrow = 2, ncol = 3, byrow = T)

∗ Datová tabulka:

Tab <- data.frame(A, row.names = c('r1', 'r2'))

names(Tab) <- c('s1', 's2', 's3')

– Základńı operace

∗ +, -, *, /

3 + 2 - 6 * 9 / (8 + 9 - 5)

∗ Operace s č́ısly

a <- 25

b <- 5

a / b

∗ Operace s vektory

x <- c(1, 2, 3)

y <- c(3, 2, 1)

x - y

x + y

z <- c(0, 1, 2, 3)

x + y + z

# !Pozor, vektor z je delsi nez vektory x a y.

# R sice napise varovnou hlasku, ale vypocet i tak provede!

∗ Operace s maticemi
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B <- matrix(c(1, 1, 1, 1, 1, 1), nrow = 2, ncol = 3)

A - B

C <- matrix(c(1, 1, 1, 1, 1, 1), nrow = 3, ncol = 2)

A - C

# !Matice A ma rozmer 2x3, matice C ma rozmer 3x2.

# Nyni jiz R vypocet neprovede, pouze zahlasi chybu.

– Pokročilé operace

∗ Délka vektoru a dimenze matice

length(z)

dim(A)

∗ Minimálńı a maximálńı hodnota vektoru a matice

min(z)

max(z)

min(A)

max(A)

∗ Součet hodnot a aritmetický pr̊uměr vektoru a matice

sum(z)

sum(A)

mean(z)

mean(A)

∗ Mocniny a odmocniny

(odmocnina <- sqrt(2))

odmocnina ^ 2

∗ Zakrouhlováńı

round(odmocnina, digits = 3) # klasicke zaokrouhleni na tri desetinna mista

floor(odmocnina) # zaokrouhleni na nejblizsi nizsi cele cislo

ceiling(odmocnina) # zaokrouhleni na nejblizsi vyssi cele cislo

– Vytvářeńı posloupnost́ı

∗ Posloupnosti č́ısel se vzdálenost́ı 1

(x <- 1:10)

(y <- 50:55)

∗ Posloupnosti č́ısel s libovolnou ale ekvidistantńı vzdálenost́ı

# Posloupnost cisel s predem zadanou delkou (R dopocita vzdalenost mezi sousedicimi cisly)

(pst <- seq(from = 0, to = 1, length = 12))

# Posloupnost cisel s predem zadanou vzdalenosti mezi sousedicimi cisly (R dopocita delku)

(pst2 <- seq(from = 0, to = 1, by = 0.09))

∗ Posloupnosti opakuj́ıćıch se č́ısel

vaha <- c(58, 61, 57, 59, 60, 54, 64, 71, 66, 70)

divky <- rep(1, 6)

chlapci <- rep(2, 4)

(pohlavi <- c(divky, chlapci))

∗ Př́ıdáńı nového řádku (resp. sloupce) ke stávaj́ıćımu vektoru
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(data <- matrix(c(vaha, pohlavi), nrow = 2, ncol = 10, byrow = T))

(data.r <- rbind(vaha, pohlavi)) # pridani radku k vektoru (vznikne matice dimenze 2x10)

(data.c <- cbind(vaha, pohlavi)) # pridani sloupce k vektoru (vznikce matice dimenze 10x2)

diabetes <- rep(0, 10)

(data.r2 <- rbind(data.r, diabetes)) # pridani radku k matici 2x10 (vznikce matice 3x10)

(data.r3 <- cbind(data.r2, c(62, 2, 1))) # pridani sloupce k matici 3x10 (vznikce matice 3x11)

∗ Př́ıdáńı nového řádku (resp. sloupce) ke stávaj́ıćı matici

data <- matrix(c(vaha, pohlavi), nrow = 2, ncol = 10, byrow = T)

data.r <- rbind(vaha, pohlavi) # pridani radku k vektoru (vznikne matice dimenze 2x10)

data.c <- cbind(vaha, pohlavi) # pridani sloupce k vektoru (vznikce matice dimenze 10x2)

diabetes <- rep(0, 10)

data.r2 <- rbind(data.r, diabetes) # pridani radku k matici 2x10 (vznikce matice 3x10)

data.r3 <- cbind(data.r2, c(62, 2, 1)) # pridani sloupce k matici 3x10 (vznikce matice 3x11)

– Podmnožiny vektor̊u a matic

∗ Výběr konkrétńıch hodnot z vektoru

vyska <- c(133, 132, 145, 126, 127)

vyska[c(2, 3, 4)]

vyska[2:4]

∗ Výběr konkrétńıch řádk̊u z matice

data.r3[1, ] # vyber prvniho radku

data.r3[2, ] # vyber druheho radku

∗ Výběr konkrétńıch sloupc̊u z matice

data.r3[ ,4] # vyber ctvrteho sloupce

data.r3[ ,8] # vyber osmeho sloupce

data.r3[ , c(3, 5, 8)] # vyber tretiho, pateho a osmeho sloupce najednou

data.r3[1:2, 5:7] # vyber cisel z prvniho a druheho radku a pateho, sesteho a sedmeho sloupce

– Práce s datovým souborem

∗ Zjǐstěńı absolutńı cesty k aktuálńı složce a výpis všech soubor̊u z této složky

getwd() # absolutni cesta k aktualni slozce

dir() # vypis souboru

∗ Načteńı datového souboru a vypsáńı prvńıch tř́ı řádk̊u z datového souboru (tabulky)

# Nacteni datoveho souboru: read.delim()

# sep: separator sloupcu, napr. tabulator '\t'; strednik ';' nebo carka ','

# dec: oddelovac desetinnych mist pouzity v souboru, napr. carka ',' nebo tecka '.'

data <- read.delim('Zaznam teploty.txt', sep = '\t', dec = '.')

head(data, n = 3) # vypsani prvnich tri radku

Hodina Teplota

1 0 38.0

2 2 37.7

3 4 37.3

∗ Výběr konkrétńıch řádk̊u z tabulky

data[4:6, ]

∗ Výběr konkrétńıch sloupc̊u z tabulky (v́ıce možnost́ı)
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# Vyber prvniho sloupce s nazvem 'Hodina'

data[ ,1]

data[ ,'Hodina']

data$Hodina

# Vyber druheho sloupce s nazvem 'Teplota'

data[ ,2]

data[ , 'Teplota']

data$Teplota

hodiny <- data$Hodina

teploty <- data$Teplota

– Logické operátory

∗ Rovnost ==, větš́ı >, menš́ı <, větš́ı nebo rovno >=, menš́ı nebo rovno <=

(teploty == 37.7)*1

sum((teploty==37.7)*1) # kolikrat byla teplota rovna 37.7

(teploty <= 37.7)*1

(teploty >= 37.7)*1

(teploty < 37.7)*1

(teploty > 37.7)*1

∗ Výběr řádk̊u s konkrétńı vlastnost́ı

data[data$Teplota == 37.7, ]

data[data$Teplota == 37.7, 'Hodina']

– Tvorba základńıch graf̊u př́ıkazem plot(x, y)

1. Povinně volitelné argumenty funkce plot(x, y)

∗ x - proměnná, která se vykresĺı na ose x

∗ y - proměnná, které se vykresĺı na ose y

2. Volitelné argumenty funkce plot(x, y)

∗ main - nadpis grafu (v publikaćıch nepouž́ıváme, nahrazujeme popiskem pod grafem)

∗ xlab - popisek osy x v grafu

∗ ylab - popisek osy y v grafu

∗ col - základńı barva objekt̊u (body, čáry) v grafu

∗ type - typ grafu

· type = ’p’: bodový graf

· type = ’l’: spojnicový graf

· type = ’b’: kombinace bodového a spojnicového grafu

· type = ’n’: prázdný graf

∗ pch - typ bod̊u

· pch = 1: kruh bez výplně

· pch = 19: výplň kruhu

· pch = 21: kruh s výplńı (možnost volby r̊uzných barev obvodu kruhu a obsahu kruhu)

· Daľśı typy bod̊u viz nápověda funkce points() → Details → ’pch values’

∗ bg - barva vnitřku bodu v př́ıpadě, že pch = 21

∗ cex - velikost bod̊u (defaultně cex = 1)

∗ lwd - š́ı̌rka čáry (defaultně lwd = 1)

∗ lty - typ čáry

· lty = 1: klasický styl
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· lty = 2: čárkovaný styl

· lty = 3: tečkovaný styl

· lty = 4: čerchovaný styl

∗ xlim = c(a, b) - rozsah osy x od a do b

∗ ylim = c(a, b) - rozsah osy y od a do b

∗ las = 1 - popisky měř́ıtka osy y vodorovně s osou x

plot(hodiny, teploty,

main = 'Teplota 17.9. 2018', xlab = 'cas (v hodinach)', ylab = 'teplota (Celsius)',

col = 'orchid3', type = 'b',

pch = 21, lwd = 2, lty = 2, bg = 'bisque',

xlim = c(-1, 23), ylim = c(36, 39), las = 1)
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– Doplněńı legendy do grafu př́ıkazem legend()

∗ Umı́stěńı legendy

· ’topright’: vpravo nahoře

· ’topleft’: vlevo nahoře

· ’bottomright: vpravo dole

· ’bottomleft: vlevo dole

· ’top’: nahoře uprostřed

· ’right’: vpravo uprostřed

· . . .

∗ fill - barva výplně legendy

∗ legend - popisek legendy

∗ bty = ’n’ - odstraněńı rámečku okolo legendy

∗ pch, lwd, lty - analogické argument̊um funkce plot(x, y)

∗ col - barva bodu, resp. čáry

legend('bottomright', fill = c('orchid3'), legend = c('Jonatan Kadrnozka'), bty = 'n')

# resp.

legend('bottomright', col = c('orchid3'), pch = c(21), lwd = c(2), lty = c(2),

legend = c('Jonatan Kadrnozka'), bty = 'n')
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– Export graf̊u do png souboru

∗ Ručńı export: Multifunkčńı okno → Plots → Export → Save as Image → Maintain
aspect ratio: odškrtnout → Save
∗ Export posloupnost́ı př́ıkaz̊u:

png('Nazev grafu.png')

plot(1:5, 1:5)

dev.off() # prikaz dev.off() projizdime, dokud se v konzoli neobjevi hlaska null device 1

Tip na domáćı procvičeńı: Vytvořeńı analogického grafu př́ıkazy plot(), lines() a points()

– plot(x, y, type= ’n’, ...) - př́ıprava prázdného grafu

– lines(x, y, ...) - vykresleńı čar

– points(x, y, ...) - vykresleńı bod̊u

plot(hodiny, teploty, main = 'Teplota 17.9. 2018', xlab = 'cas (v hodinach)',

ylab = 'teplota (Celsius)', type = 'n', xlim = c(-1, 23), ylim = c(36, 39), las = 1)

lines(hodiny, teploty, lwd = 2, lty = 2, col = 'orchid3')

points(hodiny, teploty, pch = 21, col = 'orchid4', bg = 'bisque', lwd = 2)

legend('bottomright', fill = c('bisque'), legend = c('Jonatan Kadrnozka'), bty = 'n')
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